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File menu commands

The File menu offers the following commands:

Exit Exits WSARCH32.



Edit menu commands

The Edit menu is currently empty.



Options menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

User Preferences Allows the user to specify default Archie server and search type.



View menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

Archie Query Allows the user to remove the query dialog bar.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.

About Displays the version number of this application.



Exit command (File menu)

Use this command to end your WSARCH32 session.    You can also use the Close command on the 
application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.
Keys: ALT+F4



User Preferences (Options menu)

When this command is selected the following Dialog will appear:

The selections for default Archie server and default search method will be stored and used as the default 
startup values, next time you run WSARCH32.

The User ID field is used in the Archie Request to identify you. This does not need to be changed from 
'nobody', the default value.

The Max Hits field maybe set to any value from 1 to 500 and is the maximum number of matches that the 
archie server will make.    Setting this to a value like 20, will help to decrease the amount of time taken to 
perform your query.



Help Contents command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using WSARCH32 and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Help Topics command (Help menu)

Use this command to display the Help index.



About command (Help menu)

Use this command to display the about dialog.

See Copyright for fuller details on the copyright notice and licensing information from the University of 
Southern California.



Performing an Archie Query

1. To perform a query enter a search string in the Search for box.

2. Select an archie server from the archie server drop down list.

3. Enter a match domain if desired, e.g. "uk" to restrict the search to entries for hosts end with
"uk" or "src.doc.ic.ac.uk" to restrict the search to the that site.

4.
To start the query press return, Alt+E or use the mouse on the "Search button" . 
The "Search for", "Archie Server" and "Domain" boxes are disabled along with the search 

type radio buttons and the "Search" button. The "Abort"  button is enabled.

If desired the user may abort the search at any stage by pressing Alt+B or by selecting the "Abort" button.

Whilst the query is being performed, various status indications are given in order that the progress of the 
query may be seen. The indications are in the status bar, and also in the title bar of the application. The 
following is a brief description of the stages of an archie query

1. A name look up is done to translate the name of the archie server to numeric form.

2. When this completes a request is put together and sent to the archie server. At this point 
the title bar changes and will give the name of the archie server along with the initial time 
out period. If no response is received, the time period is doubled and the request re-
transmitted. This will be repeated up to three times before the request is deemed to have 
failed.

3. If a packet is received, the archie server will send back an acknowledgment from which 
may contain queue position and system time. You will not be advised of any changes in 
either of these, as they are sent once only by the archie client. The values returned are 
displayed in the status bar. The time out period will also be set to a value advised by the 
archie client, usually 900s if it your query is not going to be performed immediately.

4. The next packet from the archie server usually adjusts this to 180s and is a good indication 
that your query is now being processed.

5. When packets start to arrive the time out is then reduced to 5s and the packets received 
are indicated in the status bar. When the total number of packets is known this will be 
displayed as "packet x of y", otherwise "packet x" is displayed.

6. When the last packet is received, WSARCH32 will translate the results. If there are a large 
number of matches, this can take several seconds.

7. The results will then be displayed in the Result View. The first host will be displayed 
selected. The directories on that host that contain matches are then displayed with the first 
directory selected. The files in that directory are then displayed with the first file selected. 



Further details on the selected file are displayed in the file details section.

Search For box

The term that will be used for the search should be entered in this box.    How this will be interpreted by 
the server is dependent on the Search Type selected.    The term is basically a simple string, e.g:

WSARCH32
pkz204g.exe

etc.



Search Type

The type of search performed by the archie client is determined using the search type radio buttons.

The choices have the following effects:

Substring: A simple, everyday substring search. A match occurs if the file 
(or directory) name in the database contains the user-given 
substring.

Substring (case sensitive): As above but the case of the strings involved becomes 
significant.

Exact: The fastest search method of all. The restriction is that the user 
string (the argument to the 'prog' command) has to exactly 
match (including case) the string in the database. This is 
provided for those of who know just what you are looking for.

Regex: Use ed(1) regular expressions. Searches the database with the
user (search) string which is given in the form of an ed(1) 
regular expression.

NOTE: Unless specifically anchored to the beginning (with ^) or
end (with $) of a line, ed(1) regular expressions have ".*" 
prefixed and appended to them. For example, the following are 
equivalent

.*xnlock.* and xnlock

Thus the regex match becomes a simple substring match.

For example:

knob - matches any string containing the substring 'knob'

a*splat - matches strings that contain zero or more a's followed
by the string 'splat'

#.*# - would match anything containing a '#' followed by zero or 
more occurrences of _any_ character, followed by another '#'

Other special characters that may be useful are '[' and ']', which
are used together. They can be used to specify either a set of 
characters to match or a set of characters to not match. An 
example of the first case is:

[abcd]

which matches any of one of the four letters, while an example 



of the second case is:

[^abcd]

in which the '^' in the first position means that any character 
not in the list will be matched.

Ranges can be specified with a '-'.

[a-z]

matches any lower case letter and,

[^a-z]

matches any character other than a lower case letter. 
Furthermore, you can specify multiple ranges such as:

[%@a-z0-9]

or

[^A-Za-z]

meaning: match '%' or '@' or any lower case letter or digit, and 
match any character other than a letter, respectively.

When you want to match a character which has a special 
meaning you should precede it by a back slash, '\'.

Some final examples of REs are:

[Mm]ac\.txt - match anything containing the string "Mac.txt" or 
"mac.txt"

[^aeiou][^aeiou]* - match any string consisting entirely of non-
vowels

foo-v[0-9]\.tar\.Z - match "foo-v0.tar.Z" through "foo-v9.tar.Z"

Exact first This is a check box and is means that the exact search method 
will be used first. If no matches are found then the method 
selected using the radio buttons will be used. This box is 
disabled if the exact search method is chosen.

Note that changing the search type selected after the search is performed will have no effect on the 
displayed list of matches.



Archie Server

This drop down list box contains the list of archie servers that are in the "Archies" section of the file 
"WSARCH32.INI" (NB this file must be in either WSARCH32's working directory, the windows directory or 
the same directory as the program). The default archie server is displayed in the box when the program is
first started.

The list supplied is that given by archie.doc.ic.ac.uk at the time of release. '*' after the name of a server 
means that it uses V3 of the Archie software. This is for information purposes only and is not used in any 
way by WSARCH32 to perform the query.

When the search is started, the Archie Server name is truncated at the first '*' or white space (tab or 
space) in the name.



Domain

This field is used to restrict the search to a subset of hosts within a particular domain, e.g. ".ac.uk" will 
restrict the search to academic sites in the UK.



Aborting a query

A query can be aborted at any stage by pressing Alt+B or selecting the "Abort" button .

Any information retrieved will be lost.



Result Views

The result view displays the result as a tree view.



File details

This section of the result display contains the following fields:

File Name This is the full name of the file. It is prefixed with "FILE: " if it is a file and 
"DIRECTORY: " if it is a file.

Size This is the size of the file in bytes.

Mode This is the access mode of the file.

Date This is the files own date stamp.

Archie Date This is the date that archie server last checked the files existence.

Host Address This is the numeric internet address of the host upon which the file resides.



Status Bar

The three boxes at the end of the status bar are used as follows (going from right to left):

The time that the archie server thinks it will take to process the query, when it starts the query.

The queue position when the query is received

The number of packets received.



Common Problems

The following is the list of known problems with WSARCH32 and how they can be solved.

1.    There is no response from the server, even though you can telnet to it.

This is usually caused by a firewall on your site blocking the incoming packets because they are UDP 
packets.    You will need to talk to your network supervisor. WSARCH32 (Version 0.2+) uses a non 
privileged port number above 2050 (the actual number may vary), so there shouldn't be problems with 
letting them in.    Some administrators take a different view and refuse to let these packets in.    There is 
nothing I can do if you cannot get the network administrator to change there philosophy.    Try the latest 
version of WSARCH32 available from http://dspace.dial.pipex.com/town/square/cc83/.

2.    You get the message "WINSOCK ERROR: NO_DATA: No entry found".

This means that the name server lookup failed.    Try using telnet to connect to the archie client.    If this 
succeeds from the same machine then there is a problem with name resolution.    If you are probably 
using Chameleon's winsock, try reducing your list of name servers to one or check whether the latest 
version fixes this.

3.    With PC-NFS V5.1 you will often get the error WINSOCK ERROR: EMSGSIZE.

I believe this is caused by an underlying restriction in the winsock stack. There is nothing that I can do 
about this.

Actually I think someone may have solved this by ensuring that all the files used by the PC-NFS software 
were in the DOS path.

4.    With Novell Winsock, an empty error dialog is displayed when a search is started.

Hopefully this version should at least display an error number here.

5. With Novell Winsock, searches fail with the error ENOBUFS.

Check your net.cfg file.    If there are lines in it like:

tcp_sockets 32
udp_sockets 8
raw_sockets 1

then taking them out might fix the problem, but will probably restrict the winsock capabilities.    I wouldn’t 
really suggest that you play with these settings unless you are fairly expert on Novell.



Copyright

This archie client is base upon the archie client that is included as part of the Prospero V5.1a release. 
Prospero comes with the following notice:

University of Southern California:

/* 
 *  Copyright (c) 1991-1994 by the University of Southern California
 *  All rights reserved.
 *
 *  PROSPERO(TM) LICENSE AGREEMENT
 *
 * 1. COPYRIGHT.  The Prospero software is owned by the University of
 *    Southern California and is protected by the United States copyright 
 *    laws and international treaty provisions.  Other copyrights may
 *    apply to parts of the Prospero distribution and are so noted when
 *    known to be applicable.
 * 
 * 2. DISCLAIMER OF WARRANTY.  THIS SOFTWARE IS PROVIDED "AS IS".  The
 *    University of Southern California MAKES NO REPRESENTATIONS OR
 *    WARRANTIES, EXPRESS OR IMPLIED.  By way of example, but not
 *    limitation, the University of Southern California MAKES NO
 *    REPRESENTATIONS OR WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY
 *    PARTICULAR PURPOSE OR THAT THE USE OF THE LICENSED SOFTWARE
 *    COMPONENTS OR DOCUMENTATION WILL NOT INFRINGE ANY PATENTS,
 *    COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.  The University of Southern
 *    California shall not be held liable for any liability nor for any
 *    direct, indirect, or consequential damages with respect to any
 *    claim by the user or distributor of the Prospero software or any
 *    third party on account of or arising from this Agreement or the use
 *    or distribution of the Prospero software. 
 * 
 * 3. GRANT OF LICENSE.
 * 
 *  a) Permission to use, copy, modify, and distribute this software and
 *     its documentation in source and binary forms is hereby granted,
 *     provided that:
 * 
 *       i) the use, copying, or distribution is not done for direct
 *          commercial advantage;
 * 
 *      ii) any distribution of the software is on the same terms as in
 *          this Prospero License Agreement, and each copy contains the
 *          copyright notices and the license agreement that appear in
 *          this software and supporting documentation; and  
 * 
 *     iii) any documentation or other materials related to such
 *          distribution or use acknowledge that the software was developed
 *          by the University of Southern California.  
 * 
 *  b) Permission to copy, modify, and distribute this software and its
 *     documentation in source and binary forms AS PART OF ANOTHER
 *     PRODUCT for commercial advantage is hereby granted, provided that:
 * 
 *       i) notice is provided to the University of Southern California
 *          describing the use of Prospero in the product;    
 * 
 *      ii) any distribution of the software is on the same terms as in
 *          this Prospero License Agreement, and those terms apply also to
 *          the distribution and use of that part of the product derived
 *          from the Prospero distribution (it is acceptable to
 *          impose additional restrictions on other parts of the product), 
 *          and each copy contains the copyright notices and the license
 *          agreement that appear in this software and supporting
 *          documentation; 
 * 
 *     iii) any documentation or other materials related to such
 *          distribution or use acknowledge that the software was developed



 *          by the University of Southern California; and
 * 
 *      iv) one of the following three conditions is met:
 * 
 *          a. The product so distributed has been developed
 *             independently and it incorporates only files and related
 *             functions (e.g. allocators) from the Prospero distribution
 *             needed to providing compatibility with the Prospero
 *             distribution; or  
 * 
 *          b. the product so distributed has been developed independently
 *             and the parts of the Prospero distribution included
 *             constitute less than 25% of the product, and the total annual
 *             sales of products incorporating Prospero does not exceed
 *             $100,000 (U.S. Dollars); or
 * 
 *          c. parties to which the product is sold or distributed are
 *             allowed to use or distribute the product in source and binary
 *             forms without fee if the party's use or distribution of the
 *             product is not for direct commercial advantage. 
 * 
 *  c) Permission to use this software to provide a service for a fee is
 *     granted provided that notice is provided to the University of
 *     Southern California describing the nature of the service and
 *     provided that the total annual revenues for the service provided
 *     using Prospero does not exceed $250,000 (U.S. dollars).
 * 
 *  d) Any use, copying, modification, or distribution other than as
 *     provided for above requires an additional license from the
 *     University of Southern California.  The University of Southern
 *     California is prepared to license this software for such use on
 *     reasonable terms.  
 * 
 * 4. OTHER RESTRICTIONS.  Nothing in this Agreement shall be construed
 *    as conferring rights to use in advertising, publicity, or
 *    otherwise, the name of the University of Southern California, or
 *    any trademark thereof. 
 * 
 *   This agreement shall be construed, interpreted, and applied in
 *   accordance with the laws of the State of California, United States of
 *   America.  If any part of this Agreement is held illegal or
 *   unenforceable, the remaining portions shall not be affected.
 * 
 *   Any notice required under this agreement shall be sent to the Prospero
 *   Project; Information Sciences Institute; University of Southern
 *   California; 4676 Admiralty Way; Marina del Rey, California 90292-6695
 *   USA. Any questions concerning the Prospero distribution should be
 *   directed to info-prospero@isi.edu.
 * 
 *   Prospero was originally written by Clifford Neuman (bcn@isi.edu) while
 *   a graduate student at the University of Washington, and subsequently at
 *   the Information Sciences Institute of the University of Southern
 *   California.  Contributors include Steven Seger Augart (swa@isi.edu),
 *   Santosh Rao (srao@isi.edu), and other individuals identified in the
 *   software distribution and accompanying documentation.
 * 
 *   Prospero, the Prospero Directory Service, the Prospero File System, 
 *   and the Prospero Resource Manager are trademarks of the 
 *   University of Southern California. 
 * 
 */

If you wish to know more about Prospero, email info-prospero@isi.edu.




